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1. Features & Facts 

 

Plugin Commander (better known as PiCo) is a tool designed to organize your Photoshop-

compatible plugins, Adobe Premiere and After Effects plugins, your Paint Shop Pro materials 

and many other plugin and file types. It also allows you to create your own Filter Factory 

plugins, convert between different plugin formats, batch process image files, manage files, to 

view and edit images and much more. 

PiCo can be used as a complementary tool with Adobe Photoshop, Adobe Premiere, Adobe 

After Effects, Jasc Paint Shop Pro, Corel Photo-Paint and many other applications that 

support plugins. However you can also use PiCo without them. 

This is the Plugin Commander Pro Edition feature list: 

 
Organize your Plugins and other Add-ons  

 Enable or disable plugins and add-ons to make only those you really 

need show up in your application  

 Support for over 30 different plugin and file types plus the ability to 

define new plugin types  

 Change the category of Photoshop-compatible, Premiere and After 

Effects plugins to make them display in the sub-menu you want  

 Simulation of Photoshop's Filter menu  

Preview Plugins and Images  

 Instant preview calculation of Photoshop-compatible plugins  

 View Paint Shop Pro Tubes, Frames, Masks, Textures, Patterns and 

Images. 

 View different image files e.g. JPG, GIF, BMP, WMF, PNG, PCX 

 Different preview possibilities: adjustable preview window, thumbnail 

browser, picture editor, Filter Factory editor 

 Apply Photoshop-compatible plugins directly to images within Plugin 

Commander to create image effects  

Edit your Images in the Picture Editor  

 Open and save different image formats 

 Acquire images from TWAIN-compatible scanners 

 Apply over 15 standard filters  

 Apply Photoshop-compatible plugins  

 Convert to various color modes (2, 16, 256 & 16 million colors, 

greyscaled, dithered)  

 Print your images  

Batch Process Images 

 Convert between different image formats  

 Create thumbnails of images and Filter Factory plugins  
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 Apply over 20 special filters during the conversion process  

 Apply Filter Factory plugins during the conversion process  

 Batch resize your images  

 Instant JPG-Quality and Effect Preview  

Convert between different Filter Factory Plugin Formats  

 Photoshop to Premiere and vice versa 

 Macintosh to Windows and vice versa 

 Old to new Filter Factory plugin versions and vice versa 

 Create Filter Factory plugins with larger previews that work in different 

color modes, demo plugins and editor plugins 

 Decompile Filter Factory plugins to source code files 

Archive your Filter Factory Plugins 

 Store your Filter Factory plugins inside FFL files with a compression 

ratio of up to 200:1  

 Search function for finding certain filters within FFL files  

 Convert FFL files back to plugins  

Create your own Plugins with the Filter Factory Editor 

 Extended editing capabilities in comparison with the original Filter 

Factory plugin 

 Many additional features like source code printing, memory spots, 

randomize function, code snippet database, ff expression database 

 Several cool graphic interfaces to inspire your creativity  

File Management 

 Two pane main window to manage folders and files quickly and easily  

 Quickly select the recently accessed folders  

 9 different file view mode  

 File Operations: copy, move, rename, delete, kill  

 Folder Operations: move, rename, kill, create  

 Start external applications by double clicking files  

 Zip and unzip files  

Flexibility & Speed 

 Multithreading for doing different tasks at the same time  

 Accelerated plugin recognition by caching  

 Fast preview of Photoshop-compatible plugins through caching  

 Menu lists for quickly swapping folders, preview images and for 

starting external applications  
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1.1 Limitations of the free Plugin Commander Light 

 The Light Edition is not optimized for speed  

 No cooperative multithreading  

 No caching of plugins and preview images  

 Applying Photoshop-compatible plugins isn't possible  

 Changing the category of non-FF plugins doesn't work  

 No Enabling and Disabling of plugins in Plugin View (with the exception of FF 

plugins)  

 No simulation of Photoshop's Filter menu  

 No Conversion of Filter Factory plugins to Adobe Premiere and Macintosh  

 No Browser dialog  

 No Preview window for previewing Photoshop-compatible plugins and images on the 

main window  

 Only BMP and JPG files are supported  

 No Batch Processing dialog  

 Limited features in the Picture Editor  

 No Thumbnails command for creating thumbnails of Filter Factory plugins  

 No FFL View  

 No Create FFL and Add FFL commands  

 No enhanced Filter Factory dialog  

 No Unzip and Zip commands  

 
1.2 Minimum Requirements 

 Hardware:  

o Pentium processor  

o 640x480 pixel, 16bit screen display  

o 24 MB RAM  
 Software:  

o Win95 / 98 / NT  

o Recommended, but not necessary: Adobe Photoshop, Adobe Premiere, 

Paintshop Pro, Corel Photo-Paint, Painter, Picture Publisher or any other 

application that supports some kind of plugins 

 
1.3 Supported Plugin Types  

 

File or Plugin Types  
Plugin 
View 

En-
/Disable 

Change 
Category 

Preview 
Window 

Browser 
Picture 
Editor  

FF 
Editor  

Photoshop-compatible filter 
plugins 

yes yes yes yes yes yes 
Only Filter 
Factory 
plugins 

Adobe Premiere plugins yes yes Not 
Recommended  

Only Filter 
Factory 
plugins 

Only Filter 
Factory 
plugins 

Only 
Filter 
Factory 
plugins 

Only Filter 
Factory 
plugins 

After Effects plugins yes yes yes no* no* no no 

PSP 6 Patterns yes yes no yes yes yes no 
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PSP 6 Textures yes yes no yes yes yes no 

PSP 7 Textures/Patterns yes yes no yes yes yes no 

PSP 7 Masks yes yes no yes yes yes no 

PSP 7 Tubes yes yes no yes yes yes no 

PSP 7 Shapes yes yes no yes no* no no 

PSP 7 Frames yes yes no yes yes yes no 

PSP 7 Images yes yes no yes yes yes no 

PSP 7 Brushes yes yes no no* no* no no 

PSP 7 Gradients yes yes no no* no* no no 

PSP 7 Styled Lines yes yes no no* no* no no 

PSP 8/9 Textures/Patterns yes yes no yes yes yes no 

PSP 8/9 Masks yes yes no yes yes yes no 

PSP 8/9 Tubes yes yes no yes yes yes no 

PSP 8/9 Shapes yes yes no yes no* no no 

PSP 8/9 Frames yes yes no yes yes yes no 

PSP 8/9 Images yes yes no yes yes yes no 

PSP 8/9 Brushes yes yes no no* no* no no 

PSP 8/9 Gradients yes yes no no* no* no no 

PSP 8/9 Styled Lines yes yes no no* no* no no 

PSP 8/9 Scripts yes yes no no* no* no no 

PSP 8/9 Selections yes yes no no* no* no no 

PSP 8/9 Deformation Maps yes yes no no* no* no no 

ACDSee plugins  yes yes no no* no* no no 

Acrobat plugins yes yes no no* no* no no 

ActiveX plugins yes yes no no* no* no no 

Avid Expresss yes yes no no* no* no no 

Corel I/E Filter plugins yes yes no no* no* no no 

Hollywood FX Effects yes yes no no* no* no no 

Illustrator plugins yes yes no no* no* no no 

Indesign plugins yes yes no no* no* no no 

Lightwave plugins yes yes no no* no* no no 

Maya plugins yes yes no no* no* no no 

Painter plugins yes yes no no* no* no no 

Paintshop Pro Tubes yes yes no no* no* no no 

PhotoImpact plugins yes yes no no* no* no no 

Photo-Paint plugins yes yes no no* no* no no 

Photoshop Actions yes yes no no* no* no no 

Photoshop Automation 
plugins 

yes yes no no* no* no no 

Photoshop Color Picker 
plugins 

yes yes no no* no* no no 

Photoshop Export plugins yes yes no no* no* no no 

Photoshop Extension 
plugins  

yes yes no no* no* no no 

Photoshop File Format yes yes no no* no* no no 



Plugin Commander Manual  8 

plugins 

Photoshop General plugins yes yes no no* no* no no 

Photoshop Import plugins yes yes no no* no* no no 

Photoshop Parser plugins yes yes no no* no* no no 

Photoshop Selection 
plugins 

yes yes no no* no* no no 

QuarkXpress XTensions yes yes no no* no* no no 

Quick Time Extensions yes yes no no* no* no no 

trueSpace plugins yes yes no no* no* no no 

Ulead Audio plugins yes yes no no* no* no no 

Ulead Filter plugins yes yes no no* no* no no 

Ulead FX plugins yes yes no no* no* no no 

Ultimate Paint plugins yes yes no no* no* no no 

* usually not possible, unless there's a preview image for the appropriate plugin available 

 

1.3.1 Supported Filter Factory Versions 

 Adobe Photoshop for Windows  

o Version 3.0 (57344 bytes): released 1994 by Adobe  

white background  

o Version 3.0.4 (49152 bytes): released 1995 by Adobe  

grey background  

o Alf's Power Toys Version (53760 bytes): created 1995 by Alfredo Mateus  

white background  

o Johann's Version (49664 bytes): created 1997 by Michael Johannhanwahr  

grey background, larger preview, copyright display  

 Adobe Photoshop for Macintosh  

o Version 3.0 (99840 bytes): released 1994 by Adobe 

 Adobe Premiere for Windows  

o English Version 2.51 (50176 bytes): released 1995 by Adobe  

smaller preview  

o English Version 4.2 (50176 bytes): released 1996 by Adobe  

larger preview, but slider values and author text overlap preview  

o German Version 4.2 (50.688 bytes)  

o English Version 5.0  

o English Version 5.1  

o English Version 5.1c  

 

1.3.2 Supported Transition Factory Versions 

 Adobe Premiere for Windows  

o English Version 4.2  

o German Version 4.2  

o English Version 5 
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o English Version 5.1a/c  

 

1.3.3 Supported Source Code Files  

Ext Description 

    

txt Text file that contains Filter Factory source code 

afs Photoshop Filter Factory source code file 

pff Premiere Filter Factory source code file 

ffl 
Filter Factory Library file that can contain up to 100.000 Filter Factory 

source codes 

ffx 
Filters Unlimited source code file which isn't fully compatible with Filter 

Factory  
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2. Introduction 

 

2.1 Basics Principles 

To use Plugin Commander (PiCo) effectively you need to learn some basic principles. If you 

have used tools like Norton Commander you should find these familiar.  

There are two panes in the main PiCo window. Each contains the File View, Plugin View and 

FFL View tabs. One of the panes is always active, the other always passive. When you click 

on one of the panes, it becomes active and the opposite pane becomes passive. The 

background of the list box in the passive pane is grey. In the picture below the right pane is 

the passive one.  

   

Before pressing a button or selecting a command from the menu, you have to select one or 

more files, plugins or FFL entries from one of the panes. All commands are related to the 

active pane. Some commands like Copy, Move, Add to FFL, Create FFL, Plugin List and 

Convert use the folder displayed in the passive pane as the destination folder. This folder is 

then displayed by default in the Select Folder dialog which appears when you execute one of 

the commands. You can select another folder or keep the default one. Pressing Ok will finally 

execute the command.  

Below the two panes is a button bar for easy access to frequently used commands. At the 

bottom of the window is a status bar for displaying a progress bar and various information 

like the number of files or the time needed to finish a command.  

Tip: If you don't know what a certain button, check box or other control does, just hover the 

cursor over it for a few seconds. A small tool tip explanation will appear. Pressing the F1 key 

will always display the appropriate help page.  

 

TextPiCo15ProHelpViews_FileView.htm
TextPiCo15ProHelpViews_PluginView.htm
TextPiCo15ProHelpViews_FFLView.htm
TextPiCo15ProHelpSelectFolder.htm
TextPiCo15ProHelpbuttonbar.htm
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2.2 Step by Step Instructions 

 

2.2.1 Navigating in File View 

 
Choosing a pane to work with 

When opening Plugin Commander you will see a main window with two large 

tabbed panes, one on the left and one on the right. One pane, the source pane, 

is always active while the other pane, the destination pane, is always partially 

grayed out. It doesn't matter with which pane you are working, both let you do 

the same things. 

To choose a pane as the active pane simply click somewhere in the file list of 

the pane. The other pane will automatically become the passive one and will 

become partially gray. 

 

Choosing a specific drive 

 

1. To choose the drive, e.g. where your plugins are located, click on the arrow 

down sign of the drive box which is located at the left top of a pane. 

2. From the appearing list select the drive you want to switch to. 

 

Choosing a specific folder 

When opening Plugin Commander for the first time the File View will be set to 

the folder in which Plugin Commander is located. To choose another folder, 

e.g. your plugin folder, it is recommended to switch to the root folder of your 

hard drive. 

1. If the root folder of your hard drive isn't displayed in the active pane, press 

the Del key several time until the file list doesn't change anymore. As an 

alternative you can also click the symbol (located in the first line of the 

file list) several times. 
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2. In the root folder of the drive, you can switch to one of the folders by double 

clicking it. 

3. To reach a specific sub folder simply make your way through the folder 

hierarchy by double clicking the folders.  

The current folder path is always displayed, sometimes truncated, at the left 

bottom of the pane. 

 

Switching View Modes 

By default the Details File View mode is displayed. This mode corresponds to 

the Details View of the Internet Explorer. If you don't like this mode, you can 

also switch to a different mode. 

1. To switch to a different File View mode, click on the symbol at the 

right top of the pane. 

2. A context menu will appear which lets you choose between different modes. 

3. After clicking on the mode you would like to be displayed, the File View 

appearance will change. 

4. To switch back to the recent mode, simply repeat step 1 to 3. 

  

Displaying only certain file types 

By default all available file types will be displayed in the file list. If you only 

want to see certain file types, e.g. only Photoshop-compatible plugins, you can 

use the File Type box. 

 

1. To display a list of predefined file types click on the arrow down handle of 

the box located at the right bottom of the pane. 

2. From the appearing list choose the file types you would like to see 

displayed. Alternatively you can also enter a file pattern in the box. For 

example entering *.8bf will display all file with the .8bf file extension. 
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Sorting the file list 

By default the file list is sorted by file name in alphabetically ascending order. 

But sometimes it is quite useful to have the file list sorted, e.g. by file creation 

date, to find recently saved or modified files faster. 

 

1a. To sort the file list by file date, click on the Date column header at the right 

top of the file list. Clicking again sorts the list in the opposite direction.  

1b. To sort the file list by file size, click on the Size column header at the 

middle top of the file list. Clicking again sorts the list in the opposite direction. 

1c. To switch back to alphabetical sort order, click on the Name column header 

at the left top of the file list. 

  

2.2.2 General Tasks 

Opening your own preview image 

Plugin Commander needs an image to be able to calculate and display plugins 

effects. This preview image can be changed by the user at any time. By default 

Plugin Commander uses Test.bmp, which is located in the Plugin Commander 

folder, as a preview image. 

1. To open your own preview image, choose Open Preview Image from the 

File menu.  

2. In the appearing file dialog choose an image and press the Open button. 

3. The selected image will now be used as a preview image when previewing 

or executing plugins. To display it select Picture Editor from the View menu. 

All opened images will automatically be added to the image list directly on the 

File Menu. The next time you want to open a certain preview image, you just 

need to click the appropriate image on the File menu. 
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Previewing and applying Filter Factory plugins 

The Light Version of Plugin Commander can only preview and apply the 

effects of Filter Factory plugins with the help of the FF Editor. Filter Factory 

plugins are a special kind of Photoshop-compatible plugins which also have 

the .8bf file extension, but are usually only 49.152 bytes or 57.344 bytes large.  

1. If you want to apply a plugin effect to a certain image, open the image by 

choosing Open Preview Image from the file menu. 

2. To see the effect of a Filter Factory plugin simply double click one (in File 

View, Plugin View or FFL View).  

3. The FF Editor will appear with the current preview image in the preview 

box. 

4. After setting all parameters press the Apply or Big View button to apply the 

plugin effect to the current preview image. If you just wanted to take a look at 

the plugin effect without applying it, please switch back to the main window of 

Plugin Commander. 

5. The image with the effect applied to it will finally appear in the Picture 

Editor window where you can save it if you like. 

  

Previewing images, plugin effects and PSP files (Pro Version only) 

1. To preview an image, plugin or PSP file, select it by clicking on it (in the 

file list of the File View, the plugin list in the Plugin View or the ffl list in the 

FFL View). 

2. Choose Preview from the View menu or press the  button which is 

located at the left bottom of the main window. 

 

3. The Preview window will pop up and display the image, plugin effect or 

PSP image. 
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4. The size of the Preview window can be changed by clicking and and 

dragging the borders of the Preview window. 

5. As long as the Preview window is displayed, selecting any other image, 

plugin or PSP file will instantly display it. 

6. To close the Preview window choose Preview from the View menu or press 

the  button again.  

  

Executing or Applying plugins (Pro Version only) 

Plugin Commander can execute and apply the effects of Photoshop-compatible 

plugin to images. Photoshop-compatible filter plugins can be recognized by the 

file extension .8bf. The Light Version of Plugin Commander can only run 

FilterFactory plugins with in the FF Editor. 

1. If you want to apply a plugin effect to a certain image, open the image by 

choosing Open Preview Image from the file menu. 

2. To execute a plugin, simply double click it (in File View, Plugin View or 

FFL View).  

3. The plugin's dialog will appear with the current preview image in the 

preview box. 

4. After setting all parameters press the OK button to apply the plugin effect to 

the current preview image. If you just wanted to take a look at the plugin 

without applying, simply press the Cancel button. 

5. The image with the plugin effect will finally appear in the Picture Editor 

window where you can save it if you like. 

 

Browsing (Pro Version only) 

1. To preview certain images or plugin effects as thumbnails in the Browser, 

select the appropriate images or plugins (in the File Plugin or Plugin View). If 

you want to browse all files in the current folder or plugin list, make sure that 

only one image or plugin is selected. 

2. To run the Browser simply press the Browse button at the bottom of the 

main window or choose Browser from the View menu. 
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2.2.3 Using Plugin View 

Switching to Plugin View and Using it 

Before you switch to Plugin View, please make sure that a folder with your 

plugins is displayed in the active pane. To activate Plugin View please click on 

the tab button with the same name. It may takes some time until all plugins are 

displayed, because Plugin Commander will now scan through the current 

folder and its sub folder for plugins. 

 

At the left side of the plugin view is a list with all categories that have been 

found in the scanned plugins. Clicking on one of the items will display the 

names of the plugins with that category in the right list box. For Photoshop-

compatible plugins the categories are identical with the sub menus that are 

displayed on the Filter or Effects menu of Photoshop or Paint Shop Pro. You 

can also select more than one category in the left list box if you like. 

  

Enabling and disabling plugins 

If you disable plugins, these plugins won't be recognized by the host 

application, e.g. Photoshop or Paint Shop Pro, and won't be displayed on the 

Filter or Effects menu. This can help if the Filter or Effects menu got too 

crowded because of a large amount of plugins. Disabling the less useful 

plugins, lets you remove them from your host application without the need to 

uninstall them. When you need them again, you can enable them again in 

Plugin Commander. 
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You can enable or disable plugins in the File View as well as the Plugin View. 

The Light Version of Plugin Commander only lets you disable Filter Factory 

plugins in the Plugin View, but you can still disable other plugin types in File 

View. In Plugin View enabled plugins are displayed with + in front of their 

name and disabled plugin have a - in front of their name. In File View the file 

extension of disabled plugins is usually altered with an underscore or minus 

letter. 

Here are the instructions:  

1. Select the plugin(s) that should be enabled or disabled. 

2. Click on the En/Disable button at the bottom or choose Enable/Disable from 

the Commands menu. 

3. All plugins that are enabled will now be disabled and all plugins that are 

disabled are now enabled. 

  

Changing the category of plugins 

As mentioned before the categories of Photoshop-compatible plugins are 

identical with the sub menus that are displayed on the Filter or Effects menu of 

Photoshop, Paint Shop Pro or other image editing applications. So changing 

the category of a plugin makes is display in a different sub menu. 

1. Select the plugins whose category you want to change in the right list box of 

the Plugin View. 

2. Click on the Change Cat button at the bottom of the window or select 

Change Category from the Commands menu. 

3. In the appearing dialog you can enter a new category name or choose and 

existing category from the the drop down list. 

4. After clicking OK, the changes will be made to the plugins. 

  

Using Photoshop Mode  

Activating the Photoshop Mode check box at the top of Plugin View displays 

the additional sub menus that are available on Photoshop's Filter Menu. Some 

of these categories include virtual plugin entries which represent the items that 

are displayed in Photoshop, but are actually built into Photoshop and not real 

plugins. You can't do anything with these virtual items, they are just there for 

the completeness.  

The Old Photoshop Mode check box cuts off the number of categories that are 

displayed in the left list box of Plugin View and places the rest of the plugins 
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in the Other category. By doing so it almost exactly simulates what Photoshop 

3, 4 and 5 did with its Filter menu. 
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3. File / Plugin / FFL View 

 
 
3.1 File View 

The File View tab is displayed by default. It lets 

you work with files and folders in a manner similar 

to Windows Explorer.  

The top right icon above the Date column header 

lets you switch between 5 different File View 

modes: 4 of them are available in the Windows 

Explorer, too, and the last one, called Classic, is a 

Win16 style dialog. You can even have up to 8 

different File View modes by additionally using the 

folder list icon which is located left of the File 

View icon.  

The arrow icon right beside the drive box can be used to synchronize both panes. That means 

that the folder of the current pane will be displayed in the opposite pane. Clicking the Name, 

Size and Date column headers sorts the files and folders according to their names, sizes and 

creation dates. 

 

At the bottom of the tab there's a label that displays the current folder path. In Classic mode 

the file size will be displayed instead. The drop down menu to the right contains different 

file patterns for excluding or including certain file types in the File View. But you can also 

enter your own file pattern. For example entering *.bmp;*.gif;*.jpg will only display 

bmp, gif and jpg files. 

Double clicking a Filter Factory plugin will load it into the FF Editor, double clicking other 

Photoshop-compatible plugins will execute them. Double clicking an image will display it in 

the Picture Editor. If the Preview icon is active and you click on a plugin, PSP add-on or 

image, you will see a preview of it in the Preview window. Double clicking other files will 

launch the associated application. Right clicking on a file will display the Commands context 

menu, whereas right clicking on a folder or clicking on the folder label will display the 

Folders context menu. 

You can move files to a folder in the opposite pane by dragging them. You can also drag files 

over a sub folder in the same pane to move them into that sub folder. 

 
3.2 Plugin View 

Pressing the Plugin View tab will scan the current folder (and all sub folders, if not 

deactivated in Preferences) for plugins. By holding the shift key and pressing the Plugin View 

tab only Filter Factory plugins will be displayed. You can cancel the plugin scan with the Esc 

key.  

PiCo displays recognized plugins and other file types in a two list view. The categories of 

plugins and other add-ons are displayed on the left side while the right shows plugins which 

TextPiCo15ProHelpFFE.htm
TextPiCo15ProHelppictureeditor.htm
TextPiCo15ProHelpbuttonbar.htm
TextPiCo15ProHelpPrefs_Interface.htm
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belong to the selected category. Many host applications use these categories to build up a 

menu tree for displaying the plugins. So categories correspond to the sub menus that are 

displaying in your some image application's Filter, Image or Effect menu. For other file types 

e.g. PSP tubes there is no real category available. In this case you will see the name of this file 

type in brackets e.g. [PSP Tubes]. 

A"+" in front of the plugin or add-on name means that the 

plugin is enabled, a "-" means that this effect is currently 

disabled and won't be recognized by the host application. 

If you activate the Photoshop Mode check box (Pro 

Edition only), Plugin Commander will simulate Adobe 

Photoshop's Filter menu. By doing this, disabled plugins 

won't be visible any more and some categories will 

disappear, too. These will be moved to the 'Other' 

category just like in Photoshop. Some filters which are 

built into Photoshop will appear to make the Photoshop 

mode more realistic, but they aren't editable. 

At the bottom of the Plugin View there's a label that 

displays the path, name and file size of the currently 

selected plugin. Double clicking a Filter Factory plugin will load it into PiCo's FF Editor, 

double clicking other Photoshop-compatible plugins will execute them and double clicking 

other files will show up the Plugin Information dialog. Right clicking on the right list box 

displays the Commands context menu. 

By dragging plugins to a different category and dropping them there, they will be moved to 

that category if possible. You can also move plugins to the folder displayed in the passive 

pane by dragging them there. 

 
3.3 FFL View (Pro Edition only) 

The FFL View displays the contents of a FFL file. FFL files 

contain Filter Factory source code and other information for 

recompiling plugins.  

The FFL View will be displayed if you double click a FFL 

file. If you press the FFL View tab, Plugin Commander will 

grab the first FFL file in the file list or display a previously 

opened FFL file. If there's no FFL file available, PiCo will 

automatically switch back to the File View tab.  

Double clicking a FFL entry will load it into the FF Editor 

or in case the Preview icon is activate, clicking on a FFL 

entry will display its effect in the Preview window. 

Dragging and dropping files/plugins from the File or Plugin 

View to the FFL View triggers the Add to FFL command 

and adds the selected Filter Factory plugins to the FFL file. Dragging and dropping FFL 

entries from the FFL View to the File or Plugin View triggers the Convert command. 
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4. The Button Bar 

  

Plugin Commander has a button bar right below the two panes for selecting the most 

commonly used commands.  

 
4.1 The three Icons at the left bottom of the main window (Pro Edition only) 

 The Preview Icon: You can enter the preview mode by choosing 'Preview' from the View 

menu or by pressing this icon. If a plugin, PSP add-on or image is selected in preview mode, 

the Preview window will pop up and show you a preview of the selected file. The preview is 

calculated in real-time for Photoshop-compatible 8bf plugins and rendered by PSP for PSP 

add-ons. For other files Plugin Commander searches for a preview image in the Preview sub 

folder. If one is found, it is displayed. Please read the text file in the Preview sub folder for 

information on creating your own preview pictures for certain files. 

In the title bar of the Preview window behind the word 'Preview' there are some words in 

brackets that explain how the displayed image was created. (from cache) means that Plugin 

Commander already calculated an effect preview for the selected plugin and loaded the 

cached image. (calculated) means that the effect of the image 

was just calculated with the help of the current preview image 

and the plugin. (preview folder) means that an image that has 

the same name as the plugin was loaded from the preview sub 

folder. (rendered by PSP) means that Paint Shop Pro was 

executed invisible in the background to render the preview. If 

Plugin Commander was problems displaying an image in the 

Preview image, it will be left blank or 'Plugin Problem' will 

be displayed. 

The Preview window can be placed anywhere you like by dragging the title bar. You can 

resize it by dragging its borders. However with a larger Preview window it may take longer to 

calculate a plugin preview, but it will have no influence on the rendering speed of images and 

PSP add-ons. The size and position of this window will be saved and restored the next time 

you start Plugin Commander. 

If a Filter Factory plugin is selected, double clicking the image in the Preview window will 

calculate a random effect. Right clicking on it will display a part of the File menu. You can 

leave the Preview mode by clicking on the Preview icon again or by choosing 'Preview' from 

the View menu a second time. 

 The Overlay Icon: This feature will only be available if the Preview icon is active. It only 

works in conjunction with Photoshop-compatible plugins including Filter Factory plugins. If 

the Overlay icon is activated, the plugin effect applied to the preview image will remain and 

won't be removed when selecting a new plugin. That way you can preview the effect of 

consecutive applied plugins. 

 The Alpha Icon: Like the Overlay icon it will only work if the Preview icon is activated. It 

only works for Filter Factory plugins. If the currently selected Filter Factory plugin contains 
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code for manipulating the alpha channel, this feature will make it visible as a greyscaled or 

blue/yellow effect. 

 

 
4.2 The Convert Button 

The Convert command allows you to convert between different Filter Factory formats and 

source code files. To use it you have to select one or more files and then press the Convert 

button. As a result the Convert dialog will pop up. 

The Output Format drop down menu lets you select one 

of 6 different formats. The Output Settings button will 

pop up the FF/TF tab of the Preferences dialog to allow 

you to specify different options for the supported formats. 

See Preferences for further instructions. 

 

The Mac FF Adaption check box (Pro Edition only) is only 

accessible if one of the last three source code formats 

(AFS, PFF, TXT) is selected. If you activate it, the source 

code will be rewritten to work on Macintosh. If necessary 

this will be done automatically for the first three plugin 

formats. 

The Use Clipboard as Source check box will ignore the previously selected files and grab 

the Filter Factory source code from the clipboard for doing the conversion. The Use Filter 

Name as File Name check box can be useful if you want to change the usual 8+3 file names 

of your plugins to a more meaningful file name. Pressing the Start button will trigger the 

conversion process.  

 

4.3 The Browse Button (Pro Edition only) 

Clicking on the Browse button will display the Browser dialog. The Browser will only display 

thumbnails of Photoshop-compatible plugins and images. 

If just one file or no files are selected when the Browse button is pressed, all files in the 

current folder will be displayed. If two or more files are selected, only the selected files will 

be displayed. 

While the thumbnails are displayed you can interrupt this process by pressing the ESC key or 

by selecting Stop Scanning from the Browse menu. To continue the scan process select 

Continue Scanning. The Thumb Size menu item lets you choose between three thumbnail 

resolutions: 90x60, 120x90 and 160x120. The middle resolution is set by default. The 

Refresh menu item refreshes the content of the Browser window in case a file was edited 

outside of the Browser. 

Double clicking an image will display it in the Picture Editor, double clicking a Filter Factory 

plugin will display it in the Filter Factory Editor. Double clicking other Photoshop-compatible 

plugins will execute them while for other file the associated application will be started. 
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Right clicking one of the thumbnails will display the Command menu from the main 

window as a context menu. With this context menu you can perform various tasks directly 

within the browser. 

 

4.4 The Batch Button (Pro Edition only) 

Before pressing the Batch button, select one or more images or Filter Factory plugins. After 

pressing Batch button the Batch Processing dialog will display. 

This dialog enables you to change the format, size or color depth and apply filters to a large 

number of images with one click. You can use it to automatically apply selected Filter Factory 

plugins to the default preview image. You can also create thumbnails of Filter Factory plugins 

by using the Resize option. Finally you can also create random textures. 
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Options 

If you select the Ignore selected Files and create check box, all files that have been selected 

in the main window will be ignored. Instead you can specify the number and default names of 

empty images that will be created. This feature only makes sense if you use it in connection 

with the Filters tab sheet and the * button (see below!) to create random textures. 

 

The Add ... to filename feature lets you append some text to the names of the processed files. 

For example, if you want to create thumbnails of some files and place them in the same folder 

as the originals, you could add e.g. "_small" to the file name to avoid overwriting the original 

files. 

An active Overwrite Files Automatically check box will suppress the Overwrite prompt. 

Display Save Dialog for each file will let you choose a new folder and enter a new file name 

for each processed file. 

 

Output Format 

The Output Format drop down menu in the Output tab contains different image formats to 

choose from: JPG, GIF, BMP, PCX, PNG, TIF and EPS. If you select JPG, the Compression 

scroll bar will let you select the JPG compression ratio. Moving this bar will be reflected in 

the Test Preview, so you immediately get an impression of the JPG output quality. 

 

Resize 

The Resize frame contains three options to change the size of the images. Keep Original Size 

won't do any changes to the images. The second option button lets you specify a certain 

image size in pixels. Activating the Ignore Proportions check box will resize the images to 

the exactly specified pixel size, otherwise the aspect ratio of the images will be retained. The 

third option will resize the images by the specified percent value. 

 

Preview 

The Preview frame contains a image preview. At first the default preview image is displayed, 

but you can switch through all selected files by pressing the < and > buttons. The Apply 

Filters button will apply the selected filters from the Filters tab (see below!) to the Test 

Preview. 

The Filters tab lets you select different filters that will be applied during the batch process. 

The Available Filters frame contains a list of basic filters. This list of available effects can be 

extended by adding Filter Factory plugins. The available effects can be added to Applied 

Filters list. So only the filters listed in the Applied Filters list will actually be applied during 

the batch process. 
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Available Filters 

This frame contains some built-in filter which start with "Basic:" and lets you add Filter 

Factory plugins to the list. To add them press the New Filters button and select a folder with 

Filter Factory plugins. To remove all added Filter Factor filters simply click the Clear button. 

To add a filter to the Applied Filters list select one from the Available Filters list box and 

press the Add >> button or simply double click the filter. It will then be displayed in the 

Applied Filters list box to the right.  

 

Applied Filters 

To remove a filter from this list again, press the << Remove button. Use the Arrow buttons to 

change the order in which the filters are applied. The * button can be used to make the 

applied Filter Factory plugins generate random slider values. If you press this button a * will 

be placed in front of the filter name to indicate that this filter will be applied with random 

slider values. Pressing the button again will remove the *. However this button doesn't work 

with the basic filters. This feature can for example be used to create random textures with 

Filter Factory plugins in conjunction with the Ignore selected Files and create check box 

(see above!). 

To edit one of the filters in the Filter Factory Editor simply double click it. The FF Editor with 

the double clicked filter will appear. Clicking the Save As button will save the changes, close 

the FF Editor and return to the Batch dialog. To return to the Batch dialog without saving the 

settings, click on the x icon at the top of the dialog. The 'Basic' filters aren't editable, because 

they aren't Filter Factory plugins. 

The order of the filters in the Applied Filter frame is crucial, especially if you use one of the 

Color Depth filters. Most filters will only work, if the image has 16 million colors (24 bit). So 

if you should use one of the Color Depth filters (e.g. the 256 Colors filter) please make sure 

that is the last one in the row. 

As mentioned above, you can switch back to the Output tab and preview the effect of the 

filters by pressing the Apply Filters button. You can even preview the effect on every 

selected file by additionally using the < and > buttons. 
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After selecting all your preferred settings, press the Start button. To stop the batch processing 

simply press and hold the ESC key. 

 

4.5 The En/Disable Button  

By pressing the En/Disable button the state of the selected files will be inverted: all selected 

files which are currently enabled will be disabled and all disabled files will be enabled.  

For example the .8bf file extension will be renamed to ._bf, .prm to _prm, .aex to _aex or vise 

versa. All files will be disabled by replacing the . point with an _ underscore. The only 

exceptions are Photoshop-compatible plugins because some plugins misbehave if you try to 

use them without a file extension. Enabled plugins are marked with a + and disabled ones 

with a - in Plugin View.  

Disabled plugins won't show up in the appropriate host application anymore. This is an useful 

feature to prevent your image or video application from getting cluttered up with plugins and 

other add-ons. Without this feature you would have to manually rename them or 

deinstall/reinstall your effects. 

 
4.6 The Change Cat(egory) Button  

Changing the category of Photoshop-compatible plugins and After Effects plugins makes 

them appear in a different sub-menu in the host application. You can use the Change Category 

command or alternatively just drag and drop plugins into another category. The Change 

Category button only works in Plugin View. 

Only plugins for Adobe Photoshop, Adobe Premiere 5 and Adobe After Effects contain real 

categories. Other files (e.g. Adobe Premiere 4.2 plugins, MediaStudio plugins PSP tubes etc.) 

do not contain have one. If no category is available then the plugin type description, enclosed 

within brackets, is displayed in place of the category in Plugin View. 

Warning: We do not recommend changing the category of Premiere 5.x or 6.x plugins, as 

they may show up somewhere you don't want them. 

 
4.7 The Create FFL Button  (Pro Edition only) 

You can archive Filter Factory plugins in a FFL file using this button. Plugins that weren't 

created with Filter Factory or PiCo's FF Editor cannot be placed into a FFL file.  

When executing this command you will be prompted to enter a file name for the new FFL 

file, then the Select Folder dialog will appear to allow you to select a destination folder. 

You can view the newly created FFL file in the FFL View by double clicking it. 
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4.8 The Select Folder Dialog 

If you do not activate the Suppress Select Folder dialog check box in Preferences, the Select 

Folder dialog will appear after you select a command that needs a destination folder. 

Examples of such commands are Copy, Move, Convert and Batch. 

The folder of the opposite pane is automatically 

displayed as the default choice. The second item 

of the drop down menu is the folder of the active 

pane. You can also choose another folder from 

the drop down menu (which are added from the 

Folder menu), press the Select Folder button or manually enter a new folder. If the entered 

folder doesn't exist, you will be prompted to created it. 

If you convert a FFL file or unzip a zip file, there will also be an Automatically create sub 

folder(s) check box. Activating this check box, will automatically create a sub folder with the 

name of the FFL or zip file. This option helps to avoid some file chaos. 

 
4.9 The Overwrite Dialog 

The Overwrite dialog will appear every time Plugin Commander tries to create a file which 

already exists. In such a case the following dialog will appear: 

 

The dialog asks you if you want to overwrite the existing file. As a small hint the size and 

date of the existing file that would be overwritten is displayed. This should help you to decide 

if the existing file should be overwritten or not. For commands like Copy and Move the size 

and date of the source file will be displayed as well. 

You have five different buttons to tell Plugin Commander what to do. Pressing the Overwrite 

button will overwrite the displayed file, pressing the Ignore button won't overwrite it. But in 

both cases the Overwrite dialog will appear again, if another file has to be overwritten. On the 

contrary the Overwrite All button will tell Plugin Commander to overwrite all files that still 

have to be processed and Ignore All won't overwrite any files. In both cases the Overwrite 

dialog won't appear again before all files are processed. Finally pressing the Cancel button 

will abort the whole operation and stop all file processing. 
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5. The Menu 

  

5.1 The File Menu 

Open Preview Image 

Lets you open a new image which will be used 

for previewing and applying plugins. 

Save Preview (Pro Edition only) 

Lets you save the image displayed in the Preview 

window. 

Randomize (Pro Edition only) 

This item is only active when the Preview 

window is visible and a Filter Factory plugin is 

selected. It will create random slider values for 

displaying the plugin effect. The same effect can 

be achieved by double clicking on the image in 

the Preview window. 

Update (Pro Edition only) 

This menu item will only be active, if the 

Preview Cache in Preferences is activated, the 

Preview window is visible and the image in the 

Preview windows was fetched from a cache file. 

The Update command will recalculate the effect 

and overwrite the old cache image.  

Set as Wallpaper (Pro Edition only) 

This item is only active if the Preview window is 

visible. Sets the image displayed in the Preview 

window as the desktop wallpaper. 

The Image items 

There's a list of images in the File menu. These 

images that have been opened recently with the 

Open Picture command or were added to this 

menu in Preferences. Selecting one of them will 

load it as the current preview image for 

previewing plugins. Selecting Edit Folder List 

at the top of this list will display the Images tab 

of the Preferences dialog for editing the image 

list. 
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Preferences 

Displays the Preferences dialog. 

Exit 

Quits this program. 

  

5.2 The Edit Menu 

Refresh 

Refreshes the contents of the File, Plugin or FFL View of the 

active pane. 

Toggle Select 

Deselects all selected items and select all deselected items in the 

File, Plugin or FFL View of the active pane.  

Select All 

Selects all items in the File, Plugin or FFL View of the active 

pane.  

   

5.3 The View Menu 

Preview 

Activates the Preview mode. The same effect can achieved by 

clicking the Preview icon in the button bar at the bottom of the 

main window. 

File View / Plugin View / FFL View 

Switches the active pane to File, Plugin or FFL View. These 

menu items have the same effect as pressing the appropriate tab 

in the active pane. 

Browser (Pro Edition only) 

Displays the Browser. 

FF Editor 

Display the Filter Factory Editor. 
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Picture Editor 

Displays the Picture Editor. 

Batch Processing (Pro Edition only) 

Displays the Batch Processing dialog. 

FX Download 

Displays the FX Download dialog. The first tab of this dialog 

lets you connect to popular web sites which contain tons of free 

plugins and effects and the second contains hundreds of 

category sorted links to Paint Shop Pro tubes.  

Double clicking one of the URLs from the list or selecting 

Connect from the File menu will start your web browser and 

connect you to that site. Save will save the current URL list. 

Share will display the path of the file the list was saved to. 

With Exit you can leave this dialog.  

Choosing Copy URL from the Edit menu will copy the selected 

URL to the clipboard. With Add you can add a new URL to the 

list. Edit Name and Edit URL let you edit the name and URL 

of a selected entry. Delete will delete the selected entry from 

the list.  

You can change the position of an list item by holding down 

the Alt key and pressing the cursor keys. 

  

5.4 The Command Menu 

Commands that generally apply to File View 

Rename 

If only one file is selected you will be prompted to enter a new 

name for it. If more than one file is selected, you will be 

prompted for a new file extension for these files.  

If a folder is selected, the Rename Folder command from the 

Folders menu will be triggered. 

Copy 

Copies all selected files to a different folder. 

Move 
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Moves all selected files to a new folder. That means that they 

are copied to a new folder and the files in the old folder are 

deleted. 

If a folder is selected, the Move Folder command from the 

Folder menu will be triggered. 

Delete 

Deletes all selected files by moving them to the trash can. You 

can still recover these files by using the trash can. 

If a folder is selected, the Kill Folder(s) command from the 

Folder menu will be triggered. 

Kill 

Deletes all selected file without moving them to the trash can. 

So they will be lost. 

If a folder is selected, the Kill Folder(s) command from the 

Folder menu will be triggered. 

Properties 

Shows the Properties dialog of a selected file or folder. Pressing 

Alt + Return does the same. 

Find (Pro Edition only) 

The Find command behaves differently in the three Views. In 

File View and Plugin View the standard Windows Find dialog 

is displayed for searching for certain files or expressions within 

files. In FFL View a PiCo dialog is displayed for searching for 

certain filters. For an description of the Windows Find dialog, 

please refer to a Windows documentation. 

The FFL View Find dialog has a Case Sensitive check box that 

can be activated, if you like to do a case sensitive search. You 

can enter one or two key words. If you want to enter two 

keywords, you have to separate them with one of the following 

search operators: 

   & means Logical AND 

   ! means Logical NOT 

   | (use Alt + Ctl+ <) means Logical OR 

Here are some search examples: 

  Gallery searches for the string "Gallery" in the filter 

name, category, author and copyright fields. 
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  Gallery N searches for all filters with the category 

<Filter Factory Gallery N> 

  Gallery&Mario searches for filters created by <Mario> 

and that have the category <Filter Factory Gallery> 

  Gallery N&Mario searches for filters created by  

<Mario> and with the category <Filter Factory Gallery 

N> 

  Gallery!Werner Streidt searches for all filters with 

the category <Filter Factory Gallery>, but excludes 

those that are written by <Werner Streidt> 

  Mario|Andrew searches for all filter that were created 

my Mario or Andrew 

Unzip (Pro Edition only) 

Unzips all selected zip files. 

Unzip & Run (Pro Edition only) 

 

Unzips all selected zip files to a temporary folder and displays a 

dialog for executing these files. This command can be useful, if 

you want to look at the contents of a zip file or want to run 

Setup.exe or Install.exe from within a zip file without unzipping 

it at first.  

You will be automatically prompted to delete the temporary 

files after you used them and don't need them anymore. 

Zip (Pro Edition only) 

Archives all selected files into a zip file. 

 

Commands that generally apply to Plugin View  

 

Enable/Disable 

Enables or disables plugins. See the En/Disable button. 

Change Category 

Changes the category of plugins. See the Change Category 

button. 

Invoke (Pro Edition only) 

Executes a selected Photoshop-compatible 8bf plugin in the 

same way that it is done in image applications by selecting a 

filter plugin from the menu. You can achieve the same effect by 
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simply double clicking a 8bf file. After pressing the OK button 

on the plugin's dialog, the effect will be rendered and displayed 

in the Picture Editor. 

 

Plugin Commander should be able to execute most Photoshop-

compatible filter plugins, but there may be a few which are 

incompatible, because they are badly coded or don't comply 

fully with the Photoshop Plugin SDK. In the worst case such a 

plugin could crash Plugin Commander. 

Plugin Information 

Shows some information about the selected plugin file. 

Plugin About Dialog 

Shows the internal About dialog of the selected plugin. 

 

Commands that generally apply to FFL View or FFL files 

Create FFL (Pro Edition only) 

Archives the selected Filter Factory plugins and source files into 

a FFL file. This command works in all three views: File, Plugin 

and FFL View (See Create FFL button).  

Add to FFL (Pro Edition only) 

Adds the selected Filter Factory plugins and source files to a 

FFL file that is currently displayed in the FFL View of the 

opposite pane. If both panes display a FFL File, you can use this 

command to copy filters from one FFL file to the other. 

Plugin List 

Displays the Plugin List dialog for saving the filter names, 

categories, file names, author and copyright of the selected 

plugins to a text file. If the Copy to Clipboard check box is 

active, they will be copied to the clipboard. Otherwise you can 

enter a file name for the text file to be created. This command 

works in all three views: File, Plugin and FFL View. 

Thumbnail (Pro Edition only) 

Using the Batch command to create thumbnails of Filter Factory 

plugins is easier than using this command. However if you want 

to produce thumbnails from the FFL View, you have to use this 

menu item.  

 

It creates thumbnail in BMP format of the selected Filter 
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Factory plugins. The size of these BMP images depends on the 

size of the Preview window. So you can use the Preview icon to 

display and resize the Preview window before using the 

Thumbnail command. This command works in all three views: 

File, Plugin and FFL View. 

   

5.5 The Folders Menu 

Move Folder 

Moves the selected sub folder to a new folder. 

Rename Folder 

If a sub folder is selected, this function lets you rename it. If no 

sub folder is selected, you will be able to rename the folder that 

is currently displayed. 

Kill Folder(s)  

Will completely erase all sub folders and files contained in the 

selected folder or folders. Be careful with this command! 

Create Folder 

Prompts you for entering a new folder name and creates it. 

The Folder items 

At the bottom of the Folders menu there's a list of folders that 

have been accessed recently or that were added to this menu 

from Preferences. Selecting one of them will display this folder 

in the File View of the active pane. Selecting Edit Folder List 

at the top of the list will display the Folder tab of the 

Preferences dialog for editing the folder list. 

  

5.6 The Apps Menu 

This shows the list of applications added to this menu through the Apps tab of 

Preferences or when executed within Plugin Commander. Selecting one of the 

items will start the appropriate application. If a "%1" is appended to the 

application name, the currently selected file in File View will be passed to the 

application as a parameter. So you can use this menu to start image 

applications or to display files selected in Plugin Commander with an external 

application. 
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Selecting Edit Application List at the top of this list will display the Apps tab 

of the Preferences dialog for editing the application list. 

 
 
5.7 The Help Menu 

Help 

Displays the Help files in your web browser. 

Tutorials 

Displays the Tutorial section of the Help files in your web 

browser. 

Tip of the Day 

Displays dozens of show short and helpful tips about Plugin 

Commander. 

Online 

The Plugin Site.com 

Starts your web browser and automatically 

connects you to the homepage of Plugin 

Commander for reading the latest news, getting 

updates etc.  

The PiCo Newsletter 

Starts your web browser and automatically 

connects you to the web page of the Plugin 

Commander Newsletter. You can subscribe 

yourself there or read the latest news. 

Add URL to Favorites 

Adds the URL of The Plugin Site site to Internet 

Explorer's Favorites menu. 

Add URL on Desktop 

Creates an icon on your desktop which lets you 

connect to the The Plugin Site by clicking on it. 

Send Email 

Comment 
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Creates a new email in your email 

application for sending a 

comment or feedback about 

Plugin Commander. 

Technical Support 

Creates a new email in your email 

application for telling the Plugin 

Commander Technical Support 

about a problem.  

About 

Displays the About dialog with the version number and credits. 
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6. Filter Factory Editor 

  

6.1 Interface Designs 

Using Plugin Commander's Filter Factory Editor you can edit different Filter Factory plugin 

settings. To load a Filter Factory plugin into the FF Editor just double click it. There are two 

FF Editor types: a 640x480 pixel large one and one that needs a higher screen resolution and 

has some additional features. While there are several interface designs for the first type there 

is just one for the second type - called Rattler Galaxy. This is the default FF Editor design for 

the pro Edition. The second interface isn't available in the Light Edition of Plugin 

Commander. If you are going to use Plugin Commander Pro at 640x480 screen resolution, 

please select one of the other interface designs from Preferences. 

 

Please note that there is also an option in Preferences to select the Original Filter Factory 

Editor as PiCo's FF Editor. This feature is just included for fun and to demonstrate the 

contrast between the original FF Editor and PiCo's FF Editor. We do not recommend using it. 

 

6.2 Editing the Filter Settings  

Although the FF Editor window doesn't have a title bar you can drag it by clicking anywhere 

on the window background. If you move the mouse pointer over some of the labels and 

buttons, you will recognize that they will highlight. This behavior indicates that you can edit 

the label or trigger the button by clicking on it. The Filename, Category, Filtername, Author, 

Copyright, Slider 1 to 8, the slider value, A=, R=, G= and B= labels can be edited this way. 

The slider values can be changed by dragging the slider knob, by clicking on the slider bar or 

by clicking on the sliders' value labels. 

Pressing the A=, R=, G= and B= labels will each display a large text box with the Filter 

Factory source code. Pressing these labels again will make the text box disappear. The source 

code can be replaced or edited to produce your own Filter Factory plugins.  

TextPiCo15ProHelpPrefs_Interface.htm
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As a small help you can access all Filter Factory functions and variables with the Functions 

button. Pressing it will display a menu for pasting them into the code box. Besides that, the 

Code snippet database button lets you access some useful code snippets. 

The 1/3 buttons will turn the three R=, G= and B= code boxes into a single C= code box. This 

way you don't need to enter the same code three times while you are programming a new 

filter. The F button lets you select the properties of the font that is used for the code boxes. 

The buttons named 1 to 10 are memory spots. Pressing one of them will highlight it and 

store the current slider settings. Pressing a highlighted memory spot button will restore the 

saved slider settings and apply them. The Clear All button erases all stored slider settings and 

the Delete button lets you delete a single memory spot. 

The four check boxes left to the slider names are for turning the sliders into so called MAP 

controls. A MAP control consist of two sliders and one slider name. This feature is just 

included for compatibility reasons and is only used by very few plugins. So don't bother about 

these check boxes, just forget them... 

The Auto Preview check box determines if the filter preview is updated or not. The 

Magnifying Glass button lets you zoom into the preview by clicking with the left and right 

mouse buttons on the preview. The Hand button has no function at the moment. Left 

clicking on the preview will update it immediately, right clicking will display a part of the 

File menu from PiCo's main window. 

The Open Picture button lets you select a new image for previewing purposes, while the 

Save Picture button calculates the final image, displays it in the Picture Editor and opens a 

file dialog for saving it. 

The Apply (or Big View) button calculates the final image and displays it in the Picture 

Editor window. The Randomize button sets random numbers as slider values. So with this 

button you can explore the different effect that a filter is capable of. Additionally if you like 

an effect, you can store it as a memory spot. The Reset button will completely erase all filter 

settings. This function is useful if you want to start creating a filter from the scratch. Last but 

not least, the Save As button allows you to save the changes you've done. The filename which 

is entered in the Filename label is used to save the plugin.  

  

6.3 The Context Menu 

There are some hidden functions in the FF Editor. Right clicking on the background will pop 

up a context menu. 

Copy Filter to Clipboard / Paste Filter to Clipboard 

These functions will let you copy and paste the Filter 

Factory source code to and from the clipboard. If you 

want to exchange filter source codes with someone via 

email, you can use these commands. 

Alpha Channel Display 

TextPiCo15ProHelpmenu_File.htm
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If this menu item is checked, the Alpha Channel (A= code) will be displayed in the preview as 

a greyscaled or blue/red effect. It works like the Alpha Channel icon of the main window. 

Update Preview  

Will immediately update the preview. 

Apply (Filter) / Randomize / Reset / Open Picture / Save (Filter) As  

Same functions as the buttons with the same name. See above. 

Print Filter 

Print Filter will output the Filter Factory source code to your printer. 

TextPiCo15ProHelpbuttonbar.htm
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7. Picture Editor 

 

 

 

To run the Picture Editor simply choose Picture Editor from the View menu or press the F9 

key. You can open or load an image into the Picture Editor by double clicking an image file in 

the main window or double clicking an image in the Browser. You can also open an image 

directly in the Picture Editor by using Open, Acquire Image from the File menu or Paste from 

the Edit menu.  

The Picture Editor is also used to display the results of a Photoshop-compatible 8bf plugin 

which was e.g. double clicked in the main window. Pressing the Apply/Big View button in 

the FF Editor will also display the result of the Filter Factory filter in Picture Editor. 

 
7.1 File Menu 

Open 

Lets you open an image that will be displayed in Picture Editor. 

Save / Save As 

Saves the currently displayed image. 

Select Source  

Lets you select a scanning device. 

Acquire Image (Pro Edition only) 

Invokes an TWAIN-compatible scanning dialog for scanning an 

image. 

 

TextPiCo15ProHelpmenu_View.htm
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Print (Pro Edition only) 

Prints the displayed image in its actual size or scaled to the 

printing page proportions. 

Exit 

Exits Picture Editor. 

 
7.2 Edit Menu 

Undo 

Restores the state of the image before the last action. 

Copy 

Copies the image to the clipboard. 

Paste 

Retrieves an image from the clipboard. 

Resize Image (Pro Edition only) 

Lets you define a new pixel size (e.g. 640x480) or enter a 

percentage amount for changing the size of the current image. 

 
7.3 Filters Menu  (Pro Edition only) 

You can find different commands in the Filters menu for manipulating the image e.g. Invert, 

Contrast, Brightness, Gamma, Blur, Sharpen, Edge Detect, Emboss, Mirror and Rotate. 

These are standard functions that you should know from other image editing tools. If you do 

not know what they do just try them. 

The External Plugins menu item will 

display a dialog that lets you apply a 

Photoshop-compatible plugin to the 

image displayed in the Picture Editor. 

The Select Folder button lets you 

select a new folder with plugins. The 

plugin categories are displayed in the 

left list box and the plugins in the 

right one.  

To run and apply a plugin effect select 

a plugin in the right list and press the 

Run button or just double click it. The 
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calculated effect will be automatically displayed in the Picture Editor window. You can apply 

several plugins without the need to leave the External Plugins dialog. 

When you don't want to apply any more effects, simply click the OK button to leave the 

dialog. If you want to undo all effects you applied from this dialog, click the Cancel button. 

Even if you left the External Plugins dialog with the OK button, you can still undo all changes 

with the Undo command from the Edit menu.  

 
7.4 Colors Menu (Pro Edition only) 

The Colors menu offers different color conversion options to choose from. You can change 

the currently displayed image to 2 color, 16 color, 256 colors by using the standard Octree 

color reduction or Floyd Steinberg dithering. Additionally a greyscale and 16 million color 

mode is also offered.  

Tip: If you want to save the current image as a gif file, you should select 256 Colors Dithered 

from the Colors menu firstly. 
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8. Preferences 

   

The Preferences dialog can be activated with the F12 key or from the File menu. It lets you 

change different settings which are essential for using Plugin Commander. 

 
8.1 General Tab  

Misc  

Enable Cooperative Multithreading (Pro Edition only) is quite a useful feature. It allows you 

to do different tasks at the same time. For example while a FFL file or a folder with plugins is 

being scanned in one pane, you can do something else in the other pane or load a filter into 

the FF Editor. There haven't been any complications yet, but if you should encounter 

problems it would be safer to deactivate this feature. Please notice that not all commands 

support cooperative multithreading to avoid 

potential problems. 

PiCo uses the Select Folder dialog for selecting a 

destination folder for some commands. If the 

Suppress the Select Folder Dialog check box is 

activated, PiCo won't prompt you for a folder and 

automatically use the folder of the passive pane. 

PiCo supports writing FFL 1.1 files. However, 

older pre 1.0 versions of PiCo only know the FFL 

1.0 format. So if you want to distribute a FFL file, 

please activate the Write FFL 1.0 Files check box 

for compatibility reasons (Pro Edition only). FFL 1.1 

files are smaller than FFL 1.0 files and PiCo can 

process them faster. 

PiCo automatically optimizes the filter code of Filter Factory plugins. If you want to suppress 

this feature, activate the No FF Code Optimization check box. 

Load all components on startup will load all necessary components when starting Plugin 

Commander. This will slow down the startup process, but avoids waiting later. If you often 

use Plugin Commander to do some conversion or plugin management, you should deactivate 

this option. But if you use the image and preview features very often, you should activate this 

check box. 

 

Preview Cache (Pro Edition only) 

This feature is enabled by default. Every time a preview is calculated for 8bf plugins, the 

preview image is saved as a JPG file into the cache sub folder of the PiCo folder. If the same 

plugin is previewed again, the cached image is displayed instead of recalculating the preview. 

This feature can speed up the display of plugin effects tremendously, especially in the 

Browser dialog.  

TextPiCo15ProHelpbuttonbar_Browser.htm
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The Clear Cache button erases all cached preview images and frees some hard drive space. 

The JPG Compression slider lets you adjust the compression of the cached images. A 

compression ratio of 15% is set as default. A larger value results in less used hard drive space, 

but worse image quality. 

 

Associate File Types with PiCo 

Pressing the Set Associations button will associate the selected file extensions with Plugin 

Commander. This means that every time you double click a file with one of these file 

extensions, PiCo will be started. 

 

8.2 FF/TF Tab 

Every time Plugin Commander creates a Filter Factory or transitions factory plugin (e.g. when 

converting or saving plugins) it uses a file template. Filter Factory 3.0 & 3.04 templates are 

already included with PiCo, but you can also use your own templates. 

 

Photoshop FF Compilation 

There are four option buttons for selecting the Filter Factory versions you like PiCo to create. 

The Macintosh Binary files that will be created with the Macintosh FF option (Pro Edition 

only) have to be transferred to a Macintosh machine and converted to Mac Photoshop plugins 

by using Stuffit Expander. The fourth option (Pro Edition only) lets you select your own Filter 

Factory template with the help of the Browse button. 

If Big Preview or Mega Preview (Pro Edition only) is 

activated, PiCo will create Filter Factory plugins 

with a dialog that has a larger preview box. 

Normally Filter Factory plugins only work with 

RGB images. If the All Modes (Pro Edition only) 

check box is activated, the Filter Factory plugins 

created by PiCo will work in LAB, HSB and 

YCMK modes, too. But please be careful, these 

modes may crash your image application, because 

the Filter Factory plugin wasn't programmed for 

these modes.  

If the No Dialog (Pro Edition only) check box is 

activated, the dialog of all created Filter Factory 

plugins will be suppressed. This option is useful if 

you would like to create Filter Factory plugins that directly apply an effect without showing 

an dialog. The Demo Plugin (Pro Edition only) feature lets you create Demo versions of Filter 

Factory plugins by deactivating the OK button in the compiled plugin and making the plugin 

unrecognizable for Plugin Commander. If the Editor Plugin check box is activated, the final 

Filter Factory plugin will display a window with code boxes instead of the usual filter dialog. 
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Premiere FF Compilation (Pro Edition only) 

Please use the Browse button and select the Adobe Premiere Filter Factory (fl-fact.prm) & 

Transition Factory (fx-fact.prm) plugins from your Premiere plugin folder. These two files 

will be needed if you want to convert Photoshop Filter Factory plugins to Premiere Filter 

Factory plugins. The Editor Plugin check box has the same effect as described above. 

 

8.3 Interface Tab  

  

File and FFL View 

These six check boxes define the behavior of the list box in the File and FFL View.  

Full Row Selection makes the full row appear selected and not only one item of a row. 

Hover Selection will make an item selected, if 

you keep the mouse pointer one second over it. 

Flat Scrollbar makes the scroll bar appear flat. 

With Hot Tracking the items will be 

highlighted when the mouse pointer moves over 

them. Gridlines will displays grid lines within 

the list box. Auto Column Width will make the 

size of the column headers adapt automatically 

to the item size which is very useful if you e.g. 

always want to see the full file names. 

Full Row Selection and Auto Column Width are 

activated by default. This is the recommended 

setting. 

 

Plugin View 

These two check boxes let you define which files are scanned and displayed in Plugin View. 

The first check box makes PiCo scan all sub folders of the current folder for plugins. The 

second check box (Pro Edition only) enables TXT, AFS and PFF files to be displayed in Plugin 

View, too. Please notice that activating the second check box can slow down the scanning 

process when switching to the Plugin View. 

 

Select Fonts 

The two buttons let you select different fonts, font sizes and font attributes for the main 

window of Plugin Commander. These two options can be very helpful if you use a high 

screen resolution with a small fonts setting. The List Box Font button selects the font that will 

be applied to the File, Plugin and FFL View lists. The Other Font button selects the font for 

all other elements on the main window e.g. the tab headers, the folder label, the file type drop 
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down menu etc. the other fonts Plugin Commander's dialogs are influenced directly by the 

Windows system settings. 

 

Choose FF Editor Interface 

The drop down list contains interface designs (you can call them skins, if you like) for the FF 

Editor. These interface design consist of a JPG and a DES file which have to be placed in the 

interface sub folder inside the PiCo folder. 

 

8.4 Folders, Preview & Apps Tabs 

Pressing the Add button will display a dialog for selecting a folder, image or application. The 

selected item will be added to the list box on the left. The Remove button removes the 

selected item from the list box and Select All lets you select all list box items.  

A selected list box item will move up or down with 

every click on one of the Arrow buttons. You can 

use this feature to sort the list box items. Holding 

down the Alt key and using the cursor keys will do 

the same job. 

If the Auto Add check box is activated, folders, 

images and applications will be automatically added 

to the list as they are selected or opened within 

Plugin Commander. 

The Auto Top check box is only available in the 

Folders Tab. If this check box is activated, the latest 

accessed folders are automatically moved to the top 

of the Folder list. 

The Limit to ... entries text box check box is only available in the Folders Tab. It determines 

which items will be displayed in the folder list. Limiting the number of displayed items will 

make the folder list less crowded and more usable.  

Add %1 is only available in the Apps Tab. If you added a %1 to an application item, the file 

that is currently selected in File or Plugin View will automatically be appended as an 

parameter when running the applications from the Apps menu. This way you can run an 

external application and specify a file that it should load automatically.  

Remove %1 which is only available in the Apps Tab removes the %1 argument, so there will 

be no file transferred to that application when it is launched from the Apps menu. 
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8.5 Plugin Types Tab 

The Plugin Types tab sheet displays all available plugin and file types with the exception of 

Photoshop filter plugins, Adobe Premiere and After Effects plugins which are built tightly 

into Plugin Commander. The check box for each plugin or file type determines if this type is 

used or ignored by Plugin Commander. 

 

The Add button lets you add a new plugin or file type, the Remove button removes the 

currently selected plugin or file type from the list, the Edit button lets you edit the currently 

selected type and the Toggle button activates or deactivates all of them. 

If you press the Reset button, the missing default plugin or file types will be added to the list 

again. The default types are the ones that are delivered with Plugin Commander and not added 

by the user. This button is useful, if you have removed one or more default types from the list 

and would like to have them added again. Self defined types won't be erased when pressing 

the Reset button. 

After pressing the Add or Edit button the 'Add/Edit Plugin Type' 

dialog will appear. The Plugin Type field should contain the name 

of the plugin type e.g. "Illustrator plugin" and the File Extension 

field may be used for entering the file extension of this plugin type 

e.g. "aip". Remember to enter just the plain file extension (e.g. 

"aip" rather than ".aip" or "*.aip").  

The 'Get Plugin Name from' frame lets you choose one of four methods for extracting the 

plugin name from the plugin file. If you choose Description, Product Name or Internal 

Name, Plugin Commander will try to fetch the plugin name from the Version resource of the 

file. With File Name selected the file name will be used as the plugin name. File Name is the 

fastest method for grabbing a plugin name and will be used by Plugin Commander in case a 

plugin doesn't contain a Version resource. 

For more details on defining your own plugin type, please read the appropriate tutorial.  

TextPiCo15ProHelptutsdefiningplugintypes.htm
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9. Keyboard Shortcuts 

 

A - Z  In a list boxes and menus: Jump to the first entry beginning with this letter 

Esc   Interrupt a command or process 

Return / 

Enter  

In a file list: Execute Photoshop Plugin, look at FFL file or launch associated 

program 

  

F 1  Launch Help file 

F 2  Rename a file 

F 3  Unzip the selected files (Pro Edition only) 

F 4  Zip the selected files (Pro Edition only) 

F 5   Copy a file 

F 6  Move a file 

F 7   Displays the Browser (Pro Edition only) 

Shift + F 7   Create a new folder 

F 8  Displays the Picture View window 

F 9  Display the FF Editor window 

F 11  Display the FX Download window 

F 12  Displays the Preferences dialog 

  

Ctl + F 1  Switch to File View 

Ctl + F 2  Switch to Plugin View 

Ctl + F 3  Switch to FFL View (Pro Edition only) 

  

Del  Delete a file by putting it into the trash can 

Shift + Del  Delete a file without putting it into the trash can (Kill) 

  

Ctl + A  Select all items in a list or text box 

Ctl + B  Thumbnail command (Pro Edition only) 

Ctl + D  Add a file/filter to a Filter Factory Library (FFL) file (Pro Edition only) 
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Ctl + E  Enable or Disable a Photoshop, Premiere, After Effects or Mediastudio PlugIn 

Ctl + F  Displays the Find dialog (Pro Edition only) 

Ctl + H  Change the category of Photoshop PlugIn in the Plugin View 

Ctl + I  Show informations on a selected plugin 

Ctl + L  Create a FFL file (Pro Edition only) 

Ctl + O  Open an image file 

Ctl + R  Refresh File, Plugin or FFL View 

Ctl + T  Toggle Select 

  

Ctl + C  In text boxes: Copy to clipboard 

Ctl + X  In text boxes: Cut to clipboard 

Ctl + V  In text boxes: Paste from clipboard 

Ctl + Z  In text boxes: Undo last change 

   

Alt + B  Browse plugins and images (Pro Edition only) 

Alt + C  Convert plugins 

Alt + D  Enable/Disable plugins 

Alt + H  Change the category of plugins 

Alt+ L  Create a FFL (Pro Edition only) 

Alt+T  Batch process images and plugins (Pro Edition only) 
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